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The training course will cover

• Paragraph formatting

• Lists and list levels

• Paragraph styles

• Table of contents

• Section and page breaks

• Headers and footers

• Table and figure captions
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Paragraph formatting

• What's a paragraph?

A paragraph consists of any amount of text 
followed by a paragraph mark ¶. 

The mark can be displayed by clicking on 
Show/Hide ¶ in the Paragraph group on the 
Home tab
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Benefits of paragraph mark?

• You can see where paragraphs start and finish. 
Spaces are indicated by dots (.) and tabs by 
right arrows (→).
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Example 

• How many paragraphs in this text?
• Control of plant diseases
• control methods that exclude the pathogen from the host

– Quarantines and inspections: regulations that prevent the 
entrance of a new disease

– Avoidance of pathogen:
• grow plants in unsuitable conditions for pathogens
• keep plants distant from infected areas

– Use of pathogen-free propagating material
• Pathogen-free seed
• Pathogen-free vegetative materials

– Epidermal coatings: to spray a compound on the aboveground 
plant parts
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The answer
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Formatting paragraphs

Because paragraph formatting affects everything 
in a paragraph, you do not need to select the 
entire paragraph to apply the formatting. As 
long as you are positioned somewhere in the 
paragraph, any paragraph formatting you apply 
will affect the entire paragraph.
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Creating paragraphs

When you press ENTER and start a new 
paragraph, it will use the formatting of the 
previous paragraph (unless specific style settings 
override this). This way, you can create a 
bulleted list and keep entering bullets until you 
no longer need them.
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Indents and outdents

Paragraphs can be indented in relation to the 
left and right margins. Indented text is text that 
starts further in on the page than other text.
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Indenting 

A simple left indent is often used as a way of 
showing that text is subordinate to the headings 
or text around it.

The Increase Indent tool (see home tab) uses 
the default tab stops on the ruler to align text
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Indenting 

Press the button OR press Tab button
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Indenting 
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Outdenting 

Outdenting means decreasing the indent that 
has been applied to a paragraph. 

Human Physiological needs:
– Food

– Shelter

– Clothing

– Water

– Air

– sleep
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Outdenting 

Press the button OR press Shift + Tab
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Practice time
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• Paragraph formatting

• Lists and list levels

• Paragraph styles

• Table of contents

• Section and page breaks

• Headers and footers

• Table and figure captions
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Starting a bulleted list
A bullet is simply a symbol or special character 
placed at the start of a sentence or a line of text.

Bulleted lists are used to make a list stand out from 
the rest of the text and make each item in the list 
easier to identify and read.

Bulleted lists are used where the list of

items has no particular order or priority.
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Starting a bulleted list

Kingdoms of life:

Plantae

Animalia

Protista

Monera

Fungi
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Starting a bulleted list

Kingdoms of life:

• Plantae

• Animalia

• Protista

• Monera

• Fungi
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Adding bullets to existing paragraphs

In a bulleted list, each paragraph starts with a

bullet. When you apply bullets to existing text, a

bullet is placed at the beginning of each 
paragraph and the rest of the text is indented.
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Starting a numbered list

Numbered lists are used to make a list stand out 
from the rest of the text and make each item in 
the list easier to identify and read. Numbered 
lists are used where the items have a particular 
order or priority.
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Starting a numbered list

Your life priorities:

Your Life Mission…

Physical Health. ...

Quality Time With Family. ...

Healthy Relationships. ...

Mental Health. ...

Finances. ...

Self-Improvement.
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Starting a numbered list

Your life priorities:

1. Your Life Mission…

2. Physical Health. ...

3. Quality Time With Family. ...

4. Healthy Relationships. ...

5. Mental Health. ...

6. Finances. ...

7. Self-Improvement.
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Creating a multilevel list

A multilevel list is one where there are several

levels of either numbered or bulleted items.

For example, your document may need to have 
detailed paragraph numbering so that each item 
can be identified uniquely.
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• Place the cursor at the end or 
begin of the text 

• then press more indent for 
further numbering 
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Chapter numbering
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Practice time
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• Paragraph formatting

• Lists and list levels

• Paragraph styles

• Table of contents

• Section and page breaks

• Headers and footers

• Table and figure captions
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Produce great looking documents

What are styles ?

• A style is a set of character and paragraph 
formatting specifications that have been given 
a name.
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Paragraph style

Paragraph styles control all of the characteristics 
of a paragraph, such as alignment, spacing and 
all other settings that are included in the 
Paragraph dialog box.
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Paragraph style

Benefits of styles: 

1. It ensures that all similar items in a document 
are formatted in the same way. 

2. To change the appearance of a particular 
style, you can do so very easily, and 
everything formatted with that style will 
change immediately throughout the entire 
document.
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Character style

Character styles are similar to paragraph styles, 
except that they only specify character 
formatting. This includes the font, font size, 
style, colour and other settings that are included 
in the Font dialog box.

32



Applying styles to the paragraphs

The are several sets of quick styles in MS word 
located on the home tab on the ribbon
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Style modification

• Right click on a style

• Click modify

• Click on format
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Practice time
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Navigating via table of contents
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Navigating via table of contents

A table of contents: 
Is a list of the headings contained 
within a document and usually 
includes the relevant page number, 
enabling you to quickly locate 
information.
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Styles And The Table Of Contents

To establish tables of contents, you need to:

• Built a document based on headings 
formatted with styles. 

• Simply typing text into a document and apply 
formatting to the headings (e.g. bold, italics, 
font effects), but not styles, Word will not 
identify any text to place in the table of 
contents.
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How can you know a document is built 
on headings formatted with styles

• Go to view

• Tick document map (navigation pane)

• A map on the left side will appear

• Click on each on to take you to the title page

• Otherwise, there are no any applied headings 
or styles
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Means of creating table of 
contents

• A preset table of contents

• Create the table of contents using the Table of 
Contents dialog box.

• Where to create table of contents?

• Path: References tab, table of contents (far left 
side)
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Using a built in table of contents 
(preset)
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Update table of contents and page numbers

Update page numbers only

• Increase or decrease page numbers in a document

• Select table of contents

• Click on update table of contents to show:
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Update table of contents and page numbers

Update entire table

• Increase or decrease page numbers in a document

• Select table of contents

• Click on update table of contents to show: (select all then F9)
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Practice time 
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• Paragraph formatting

• Lists and list levels

• Paragraph styles

• Table of contents

• Section and page breaks

• Headers and footers

• Table and figure captions
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Section and page breaks

Section breaks

Section breaks enable you to segregate parts of 
a document, thereby applying different 
formatting and layouts to different sections.
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Types of section breaks

• Next Page

• Continuous

• Even Page

• Odd Page.
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some formatting and layout options available in 
Microsoft Word are applied automatically to an 
entire document, irrespective of whether it 
consists of one page or one hundred pages for 
example:

• headers and footers

• Margins

• page orientation

• text alignment
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Benefits of sections

• change the page orientation for individual 
pages

• change the vertical alignment of text on a 
page

• create different headers and/or footers for 
parts of a document

• create newspaper-style columns in parts of a 
document
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Section Break Types

Next Page

Is the most commonly used of the section 
breaks, especially in large documents

To make a break for Next Page:

Go to layout, click on breaks, select Next Page
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Section Break Types

Next Page

As the name implies, a Next Page section break will 
start the section on the next page. You would use this 
break when the changes you want to apply affect entire 
pages. For example if you want to: create different 
headers and footers for different chapters, or if you 
want to change the page size, orientation or the 
margins for one or a number of pages, then Next Page 
section breaks are ideal
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Section break

Insert a section break

• Open the file

• Click to the left of insertion point

• Click on the View tab, then click on Draft

• On the Page Layout tab, in the Page Setup group, 
click Breaks. 

• Click the type of section break that you want to use.

• The Next Page command inserts a section break and 
starts the new section on the next page.
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Section break
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• Press Ctrl + Home to position the insertion point

• Repeat step 2 to change the view back to Print 
Layout

• Click on the Page Layout tab then click on the dialog 
box launcher for the Page Setup group to display the 
Page Setup dialog box

• Click on the Layout tab then click on the drop arrow 
for Vertical Alignment and select Centre

• Click on [OK] to apply the changes
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Section break

• Different page No, for instance to start with
i,ii,iii,iv…….for abstract and table of content

• Then in chapter 1 starts with no 1,2,3,4………….

• Chapter 2 continuous from previous section
and so on….
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Section break

• To apply different page numbers:

• Do section break for your document

• Insert page number

• Then at the beginning of the next section
change the page number to start at 1 by:

– Select the page number of the second section

– Go to page number

– Format page numbers

– Tick start at
57



Section break

Note: dont forget to deactivate link to previous in the header and footer 58



Section Break Types

Continuous

A Continuous section break enables you to isolate text 
within a page and can be used, for instance, to create 
newspaper-style columns. By default, text on a page is 
in one column, which spans from the left to right 
margin. By inserting two continuous section breaks 
(one at the beginning of the text you want to isolate 
and the other at the end) you can apply a multi-column 
format to the section
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Section Break Types

Even Page

The Even and Odd Page section breaks are 
used in documents with double-sided 
formatting. In this case, an Even Page 
section break will start the section on the 
next even page and is useful, for example, 
to ensure that the next chapter begins on a 
left hand page.
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Section Break Types

Odd Page

An Odd Page section break will start the 
section on the next odd page and is useful 
to ensure, for example, that the next 
chapter begins on a right hand page
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Practice time 
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• Paragraph formatting

• Lists and list levels

• Paragraph styles

• Table of contents

• Section and page breaks

• Headers and footers

• Table and figure captions
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Headers and footers

• Headers are located in the margin area at the
top of the page. Footers are located in the
margin area at the bottom of a page.

• Contain information regarding the document
such as, title, author, date created &page
numbering
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Headers and footers

• The need for various headers and footers if 
you are creating a report that consists of a 
title page and several chapters such as 
chapter one and chapter two

• First Page Header/Footer –different header 
and footer enables you to construct a cover or 
title page.

• How to switch between headers and footers 
or edit them
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Headers and footers

• Open the document you want to add headers 
and footers

• Click on the Insert tab, then click on Header 
in the Header or Footer group to display the 
header style gallery then select one of 
headers

• Go to footer and select one footer

• Close header and footer
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Opening headers and footers
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Opening headers and footers
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Endnote and footnote

• Footnotes and endnotes enable you to insert
additional information

• Generally, footnotes appear at the bottom of
the page in which they are inserted while
endnotes appear at the very end of the
document
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Endnote and footnote

• Useful for co-authors in papers

• Endnote: opens in References tab but
footnote opens in insert tab
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Endnote and footnote

• For example, footnotes can be used in an
essay to give the reference details of quotes
used or additional information about a
particular issue addressed in the text.

• The number one (1) will be inserted as a
reference mark within the body of the text
and the actual note text which located at the
bottom of the page ready for you to type the
footnote text.
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Endnote and footnote

• If you add another footnote it will start 
numbering it automatically at the bottom of 
the page.

• To delete a footnote, all you need to do is to 
delete the reference mark in the body of the 
document and the footnote text will be 
deleted automatically.
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Endnote and footnote

Steps creating notes

• References select the place using cursor –
insert (endnote or footnote) – write your note 
at the bottom of page under the horizontal 
line.
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Endnote and footnote

Steps deleting notes

• Place the cursor at the right of reference mark 
– press backspace – press delete, it will 
automatically delete both the ref mark and 
the text that linked to it.
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Changing the format of end or 
footnotes
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Practice time
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• Paragraph formatting

• Lists and list levels

• Paragraph styles

• Table of contents

• Section and page breaks

• Headers and footers

• Table and figure captions
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Table and figure captions

Captions are labels that you can apply to objects 
such as tables, figures, charts and the like

Benefits

• Giving automatic and sequential numbers to 
figures, tables, etc.

• Generate a table of figures and list of tables

• Change caption labels

• Update captions, move or delete an object, the 
caption numbers are automatically adjusted to 
reflect the new order
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Captions

The caption consists of two parts: 

• A label which identifies the type of object that 
it is (e.g. table, figure etc), 

• A number to distinguish objects of the same 
label type.
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Captions

Steps:

Click on References tab, select Inert Caption to 
open this window:
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Captions

In the windows:

1. Select the figure or table in your document

2. Write the figure or table title in the con box 
of caption

3. Select a label (figure, table, ..)

4. Select the position of the label (above or 
below)

5. Other options
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Captions

Cross-reference

Means placing or pointing to a figure or table 
within a text.

Steps:

1. Click on Insert or Reference tab

2. Click on Cross-reference

3. Select reference type

4. Choose from the bottom list

5. Click insert 82



Captions

Cross-reference
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Example of a caption
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Example of a caption
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Generating list of figures
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Example of list of figures 
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Creating a caption for a table
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Generating a list of tables
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Updating captions

To update caption numbers:

1. Press ctr+A to select the document

2. Right-click on the document and select
Update Fields

3. You can also press F9 to update fields.

In long documents, to update all fields tables of
contents & indexes etc.. also consist of fields
and will also be updated.
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Practice time
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End of the short training course
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